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RISC-V MCU Smart Configurator 

User's Guide: e² studio 

Introduction 

This application note describes the basic usage of the RISC-V MCU Smart Configurator (hereafter called the 
Smart Configurator), which is an e² studio plug-in tool. 

 

References to the e² studio integrated development environment in this application note apply to the 
following versions. 

• e² studio 2024-01 and later 

 

Target Devices and Compilers 

Refer to the following URL for the range of supported devices and compilers: 

https://www.renesas.com/software-tool/risc-v-smart-configurator   
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 Overview 

 Purpose 

This application note describes the basic usage of the Smart Configurator and the e² studio integrated 
development environment, including the procedure for creating a project. 

Refer to the User’s Manual of the e² studio for how to use the e² studio. 

 

 Features 

The Smart Configurator is a utility for combining software to meet your needs. It handles the following three 
functions to support the embedding of drivers from Renesas in your systems: importing middleware in the 
form of SW integration feature, generating driver code, and making pin settings. 

 

 Software Components 

The Smart Configurator supports two types of software components: Code Generator, and RISC-V MCU 
Software Integration System: 

(1) Code Generator drivers (DTC, A/D Converter, Interrupt Controller, etc.) 

The Code Generator drivers is a control program for peripheral functions of microcomputer such as 

DTC, A/D converter, Interrupt Controller, etc. It is convenient to embed a software component using 

code generation function. 

 

(2) RISC-V MCU Software Integration System (BSP, etc.) 

The RISC-V MCU Software Integration System module is a software component of drivers, middleware 

SW that provides a simple GUI for generating code.  
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 Creating a Project 

The following describes the procedure for creating a C/C++ project using the Smart Configurator. 

Refer to the related documents on the e² studio for the details of the e² studio project creation wizard. 

(1) Start e² studio and launch a workspace. After starting, select [File] → [New] → [C/C++ Project] to 
activate the project creation wizard. 

 

   

Figure 2-1  Creating a New Project 

 

(2) In the project creation wizard, select [Renesas RISC-V MCU] → [LLVM for Renesas RISC-V C/C++ 
Executable Project], and click on the [Next] button. 

  

Figure 2-2  Templates for New C/C++ Project Dialog Box 
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(3) Enter project information. Click on the [Next] button to continue. 

(For e.g., LLVM executable project, Project name: "Smart_Configurator_Example") 

 

  

Figure 2-3  Creating a New Renesas LLVM Executable Project  

 
(4) Select the toolchain, target board, device, and debug configuration. Click on the [Next] button. 

(For e.g., Target Device: G021 – 48 pins (Part number: R9A02G0214CNE)) 

 

  

Figure 2-4  Selecting the Toolchain, Device, and Debug Configuration 
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(5) In the [Select Coding Assistant settings] dialog box, select the [Use Smart Configurator] checkbox and 
click on the [Next] button. 

 

Note: [Use Smart Configurator] checkbox is enabled only if device supported by Smart Configurator is selected 

at (4). 

 

  

Figure 2-5  Selecting the Coding Assistant Tool 
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(6) In the [Project Template Selection] dialog box, select the [Bare Metal - Blinky] or [Bare Metal - 
Minimal] project template and click on the [Finish] button. 

 

Note: [Bare Metal - Blinky] selection is supported only if the target board selected at (4) is not [Custom] and the 

selected board have the LED resource(s). The custom board is only support [Bare Metal - Minimal] project 

template. 

  

 

Figure 2-6  Selecting the Project Template 

 

(7) Wait for completion of project creation. 

 

 

Figure 2-7  Progress of Project Creation  
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(8) After a new C Project is successfully created, the project will be opened in the Smart Configurator 
perspective.  

 

 

  Figure 2-8  Smart Configurator Perspective 
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 Operating the Smart Configurator 

 Displaying the Smart Configurator Perspective 

To fully utilize Smart Configurator features, ensure that the Smart Configurator perspective is opened. If it is 
not opened, select the perspective icon in the upper right corner of the e2 studio window: 

 

 

Figure 3-1  Opening the Smart Configurator Perspective 
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 Procedure for Operations 

Figure 3-2 shows the procedure for using the Smart Configurator to set up peripheral modules and build the 
project with the e² studio. Refer to the related documents on the e² studio for the operation of the e² studio. 

 

Figure 3-2  Procedure for Operations 

  

Operations in the e² studio 

Starting the e² studio 

Creating and loading an e² studio project 

Displaying the Smart Configurator perspective 

Setting of peripheral modules 

Generating source code 

Creating user programs 

Building 

Execution and debugging 

Setting of interrupts 

Refer to section 4.6, Interrupt Settings 

Device information 

Toolchain information 

Generating reports 

Refer to chapter 9, Generating Reports. 

Setting of pins 

Refer to section 4.5, Pin Settings 

Refer to chapter 6, Generating Source Code. 

Refer to chapter 7, Creating User Programs. 

Refer to chapter 4, Setting of Peripheral Modules. 
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 File to be Saved as Project Information 

The Smart Configurator saves the setting information such as the target MCU for the project, build tool, 
peripheral modules, and pin functions in a project file (*.scfg), and refers to this information. 

The project file from the Smart Configurator is saved in “project name.scfg”, which is at the same level as the 
project file (.project) of the e² studio. 

 

 Window 

The configuration of the Smart Configurator perspective is shown in Figure 3-3 Smart Configurator 
Perspective. 

 

 

Figure 3-3  Smart Configurator Perspective 

 

(1) Project Explorer 

(2) Smart Configurator view 

(3) MCU/MPU Package view 

(4) Console view 

(5) Configuration Problems view 

(6) Developer Assist Browser 

 

  

(2) (3) (1) (6) 

(4) (5) 
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3.4.1 Project Explorer 

The structure of the folders in the project is displayed in a tree form. 

 

 

Figure 3-4  Project Explorer 

 

When the Project Explorer is not opened, select [Window]→ [Show View] → [Other] from the e2 studio menu 
and select [General] → [Project Explorer] on the opened [Show View] dialog box. 

 

3.4.2 Smart Configurator View 

The Smart Configurator view consists of seven pages: [Overview], [Board], [Clocks], [System], 
[Components], [Pins], and [Interrupt]. Select a page by clicking on a tab; the displayed page will be changed. 

 

 

Figure 3-5  Smart Configurator View 

 

When this view is not opened, right-click on the project file (*.scfg) in the Project Explorer and select [Open] 
from the context menu.  
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3.4.3 MCU/MPU Package View 

The states of pins are displayed on the figure of the MCU/MPU package. The settings of pins can be 
modified from here. 

Three types of package view can be switched among [Assigned Function], [Board Function] and [Symbolic 
Name].  

⚫ [Assigned Function] displays the assignment status of the pin setting. 

⚫ [Board Function] displays the initial pin setting information of the board. The initial pin setting 
information of the board is the pin information of the board selected by [Board:] on the [Board] page 
(refer to "chapter 4.1 Board Settings” and “chapter 4.5.6 Pin setting using board pin configuration 
information"). 

⚫ [Symbolic Name] displays the symbolic name defined by user for the pin. Macro definition for the 
symbolic name will be generated together with port read or write functions in Pin.h file. 

 

    

Figure 3-6  MCU/MPU Package View 

 
When this view is not opened, select [Renesas Views] → [Smart Configurator] → [MCU/MPU Package] from 
the e2 studio menu. 
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3.4.4 Console View 

The Console view displays details of changes to the configuration made in the Smart Configurator or 
MCU/MPU Package view. 

 

 

Figure 3-7  Console View 

 

When this view is not opened, select [Window]→ [Show View] → [Other] from the e2 studio menu and select 
[General] → [Console] on the opened [Show View] dialog box. 

 

3.4.5 Configuration Problems View 

The Configuration Problems view displays the details of conflicts between driver used interrupts, configured 
peripherals, used pins, used settings. 

 

 

Figure 3-8  Configuration Problems View 

 

When this view is not opened, select [Renesas Views] → [Smart Configurator] → [Configuration Problems] 
from the e2 studio menu. 
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3.4.6 Developer Assist Browser View 

[Developer Assist Browser] view is a particular view service for Smart Configurator Developer Assistance 
feature, user can navigate and browse API info and through "Copy" context menu to paste the Code 
Generator component usage example code snippet to C/C++ editor. 

When this view is not opened, select [Renesas Views] → [Smart Configurator] → [Developer Assist Browser] 
from the e2 studio menu. 

 

  

Figure 3-9  Developer Assist Browser View 
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 Setting of Peripheral Modules 

User can select peripheral modules from the Smart Configurator view. 

 

 Board Settings 

User can change the board and device on the [Board] page.  

 

4.1.1 Selecting the Device 

Click on the [ ] button to select a device. 

  

Figure 4-1  Selecting the Device 

The following message is displayed when changing the device.  For each button operation, refer to "Table 
4-1 Device Change Confirmation Operation List". 

 

  

Figure 4-2  Confirm Device Change 

 

Table 4-1.  Device Change Confirmation Operation List 

Button Operation explanation 

Yes Change to the selected device. 

No It does not change the device. 

Save and continue(Note*1) After saving the current configuration contents to the configuration file, change to 
the selected device. 

Continue(Note*1) Changes to the selected device without saving the current configuration contents to 
the configuration file. 

Cancel(Note*1) It does not change the device. 

Note *1: Smart Configurator view is marked with dirty *. 
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4.1.2 Exporting Board Settings 

The board settings can be exported for later reference. Follow the procedure below to export the board 
settings. 

(1) Click on the [  (Export board setting)] button on the [Board] page. 

(2) Select the output location and specify a name (Display Name) for the file to be exported. 

 

  

Figure 4-3  Exporting Board Settings (bdf Format) 

  

(1) 
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4.1.3 Importing Board Settings 

Follow the procedure below to import board settings. 

(1) Click on the [  (Import board setting)] button and select a desired bdf file. 

(2) The board of the imported settings is added to the board selection menu. 

 

  

Figure 4-4  Importing Board Settings (bdf Format) 

 

Once a board setting file is imported, the added board is also displayed in the board selection menu of other 
projects for the same device group. 

 

  

(2) 

(1) 
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 Clock Settings 

User can set the system clock on the [Clocks] page. The settings made on the [Clocks] page is used for all 
drivers. 

Follow the procedure below to modify the clock settings. 

(1) Specify the Operation mode, Type setting and VCC setting. 

(2) Select the clocks required for device operations on the board (the high-speed on-chip oscillator is 
selected by default).  

(3) Specify the frequency of each clock in accordance with the board specifications (note that the frequency 
is fixed for some internal clocks). 

(4) For the multiplexer symbol, select the clock source for the output clocks. 

 

 

Figure 4-5  [Clocks] Page 

  

(1) 

(4) 

(4) 

(4) 

(2) 

(3) 
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 System Settings 

You can set the debug interface pins at [System] tabbed page.  

There are 1 type of debug interface available: cJTAG 

You can check the pins configured from Console message or MCU/MPU Package view. 

 

 

Figure 4-6  Debug Interface Setting at [System] Page 
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 Component Settings 

Drivers and middleware can be combined as software components on the [Components] page. Added 
components are displayed in the tree view at the left of the page. 

  

Figure 4-7  [Components] Page 

 

4.4.1 Switching Between the Component View and Hardware View 

The Smart Configurator provides two views: Component View and Hardware View. User can switch two 
views by clicking the following icons:  

(1) Click on the [  (Component View)] icon. The tree view will display the components by component 

category. 

(2) Click on the [  (Hardware View)] icon. The tree view will display the components in a hardware 

resource hierarchy. 

 

  

Figure 4-8  Switching to the Hardware View 

  

Tree view for components 

(1) (2) 



RISC-V MCU Smart Configurator User's Guide: e² studio 

R20AN0730EC0101  Rev.1.01  Page 23 of 73 

Apr.22.24  

4.4.2 Adding a Software Component  

The Smart Configurator provides two methods for adding a new component: 

(a) Click on the [  (Add component)] icon.  

(b) On Hardware Tree, double-click on a hardware resource node. 

 

The following describes the procedure for adding a component by clicking on the [  (Add component)] 
icon. 

a-1. Click on the [  (Add component)] icon.  

  

Figure 4-9   Adding a Component 

 

a-2. Select a component from the list in the [Software Component Selection] page of the [New Component] 
dialog box (e.g. A/D Converter). 

a-3. Check that [Type] for the selected component is [Code Generator]. 

a-4. Click on [Next]. 

 

Figure 4-10   Adding a Code Generator Component  

a-1. 

a-2. a-3. 

a-4. 
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a-5. Specify an appropriate configuration name in the [Add new configuration for selected component] page 
of the [New Component] dialog box or use the default name (for e.g., Config_ADC).  

a-6. Select a hardware resource or use the default resource (for e.g., ADC).  

a-7. Click on [Finish]. 

 

 

Figure 4-11   Adding a Component 

 

To add a component on Hardware Tree directly, user can use the following procedure: 

b-1. Click on the [  (Hardware View Menu)] icon. The tree will display in a hardware resource hierarchy. 

b-2. Double-click on a hardware resource node (for e.g., A/D Converter) to open the [New Component] 
dialog box. 

b-3. Select a component from the list (for e.g., A/D Converter) to add a new configuration。 

b-4. Follow the same procedure is same as “Click on [  (Add component)] icon” step a-3 to a-7. 

 

 

Figure 4-12   Adding a Code Generator Component to the Hardware View  

a-5. 

a-7. 

a-6. 

b-2. 

b-3. 

b-1. 
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4.4.3 Removing Software Component 

Follow the procedure below to remove a software component or multiple components from a project. 

(1) Select a software component or multiple components (press and hold CTRL key while selecting the next 
component) on the Components tree.  

(2) Click on the [  (Remove component)] icon.  

 

       

Figure 4-13  Removing a Software Component or Multiple Components 

 

The selected software component will be removed from the Components tree.  

To delete the source files previously generated for the removed components from the e2 studio project tree, 

click [  (Generate Code)] icon. 

  

(2) 

(1) 

(1) 

(2) 
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4.4.4 Setting a Code Generator Component 

Follow the procedure below to set up a Code Generator configuration. 

(1) Select a Code Generator configuration from the Components tree (for e.g., A/D Converter). 

(2) Configure the driver in the [Configure] panel to the right of the Components tree. The following steps 
and figure show an example. 

a. Select [10 bits] under [Resolution setting]. 

b. Select [Software trigger no wait mode] under [Trigger mode setting]. 

c. Select [ANI0] for [A/D channel selection]. 

d. Select [2112/PCLKB] for [Conversion time]. 

e. Ensure ADC_ENDI has been configured a vector in [Interrupt] page, detailed usage please refer to 
4.6 Interrupt Settings. 

 

 

Figure 4-14  Setting of a Code Generator Driver 

 

Generation of a code in accordance with each Code Generator configuration is enabled by default. 

Right-clicking on a Code Generator configuration and then selecting the [ ] icon changes the 
icon to [ ] and disables code generation for the Code Generator configuration.  

To enable code generation again, click on the [ ] icon and change it to [ ]. 

 

  

(1) 
(2) b. 

(2) c. 

(2) d. 

(2) a. 

0 
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4.4.5 Changing the Resource for a Code Generator Configuration 

The Smart Configurator enables user to change the resource for a Code Generator configuration (for e.g., 
from TAU0_1 to TAU0_3). Compatible settings can be ported from the current resource to the new resource 
selected.  

Follow the procedure below to change the resource for an existing software component.  

(1) Right-click on a Code Generator configuration (for e.g., Config_TAU0_1). 

(2) Select [Change resource] from the context menu. 

 

 

Figure 4-15  Changing the Resource 

 

(3) Select a new resource (for e.g., TAU0_3) in the [Resource Selection] dialog box. 

(4) The [Next] button will be active, click on it. 

 

  

Figure 4-16  Components Page – Selecting a New Resource 

  

(1) 

(2) 

(3) 

(4) 
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(5) Configuration settings will be listed in the [Configuration setting selection] dialog box.  

(6) Check the portability of the settings. 

(7) Select whether to use the listed below or default settings. 

(8) Click on [Finish]. 

 

  

Figure 4-17  Checking the Settings of the New Resource 

 

The resource is automatically changed (for e.g., changed from TAU0_END1 to TAU0_END3). 

 

 

Figure 4-18  Resource Changed Automatically 

  

(6) 

(8) 

(7) 
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To change the configuration name, follow the procedure below. 

(9) Right-click on the Code Generator configuration.  

(10) Select [Rename] to rename the configuration (for e.g., change Config_TAU0_1 to Config_TAU0_3).  

 

 

Figure 4-19  Renaming the Configuration 

 

4.4.6 Downloading RISC-V MCU Software Integration System Modules 

RISC-V MCU Software Integration System module is another software component type which can provide 
simple view for user to make driver/middle/application SW configuration and generate the code. The 
available RISC-V MCU Software Integration System modules can be downloaded from Renesas web.  

(1) Click on [  (Add component)] as in Figure 4-9 to open New component dialog. 

(2) Click the [Download RISC-V MCU Software Integration System Modules] link in the [Software 
Component Selection] page of the [New Component] dialog box to download RISC-V MCU Software 
Integration System Modules. 

 

  

Figure 4-20  RISC-V MCU Software System Integration Module Download Entry 

(9) 

(10) 
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Note: Downloading requires login to "My Renesas". If user has not logged in, the following dialog box will prompt user 
to log in. To register as a new user, click on the [Registering at My Renesas] button. 

 

 

Figure 4-21  Login to My Renesas 

 
(3) Select the checkbox of the required module in the [RISC-V MCU Software Integration System 

Modules Download] dialog box. 

(4) Click on [Browse...] to select the location where the downloaded module is to be stored. 

(5) Click on [Download] to start downloading the selected RISC-V MCU Software Integration System 
Modules module.  

 

  

Figure 4-22  Downloading RISC-V MCU Software Integration System Modules 

  

(3) 
(4) 

(5) 
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4.4.7 Adding a RISC-V MCU Software Integration System Module 

The following describes the procedure for adding a RISC-V MCU Software Integration System Module. 

(1) Click on the [  (Add component)] icon.  

(2) Select components which [Type] is [RISC-V MCU Software Integration System] from the list in the 
[Software Component Selection] page of the [New Component] dialog box. Two or more components 
can be selected by clicking with the Ctrl key pressed.  

(3) Click on [Finish]. 

 

  

Figure 4-23  Adding RISC-V MCU Software Integration System Module 

  

(2) (3) 

(4) 
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4.4.8 Setting a RISC-V MCU Software Integration System Module 

To use RISC-V MCU Software Integration System module, configuration option should be set. Setting 
methods depend on components, 

✓ Set configuration options on Configure panel and settings will be generated to configuration file of 
RISC-V MCU Software Integration System module automatically at each time of code generation 
action. 

Note: The configuration file of RISC-V MCU Software Integration System module will be generated in the r_config 

folder. 

 

 
Figure 4-24  Setting RISC-V MCU Software Integration System Module 

  



RISC-V MCU Smart Configurator User's Guide: e² studio 

R20AN0730EC0101  Rev.1.01  Page 33 of 73 

Apr.22.24  

4.4.9 Changing Version of BSP Configuration 

The following describes the procedure for version change of BSP configuration. 

(1) From the component tree, right-click the r_bsp component whose version user wants to change. 

 

 

Figure 4-25  Version Change of BSP Configuration 

 

(2) Select [Change Version ...] from the context menu. 

(3) In the [Change Version] dialog box, select the version you want to change. If user selects a version that 
the device does not support, [Selected version doesn’t support current device or toolchain] will be 
displayed. 

(4) Click [Next].  
 

  

Figure 4-26  Select Version of BSP Component  
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(5) By version change, a list of setting items to be changed is displayed. Confirm that there is no problem 
and click [Finish]. 

 

 

Figure 4-27  Confirm Setting Change Item 

 

(6) As [Confirm to change version and proceed to generate code] is displayed, if user does not have any 
problem, click [Yes]. 

 

 

Figure 4-28  Confirm Version Change 

 

(7) The BSP component version is changed, and code generation is executed automatically. 
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4.4.10 Export Component Configuration 

The current configuration can be exported as *.xml file by clicking on the [  (Export Configuration)] button 
on the [Components] tabbed page. 

 

Figure 4-29  Export Configuration (xml format) 

 

4.4.11 Import Component Configuration 

Click on the [  (Import Configuration)] button and select an exported xml file will import component 
configuration. 

 

Figure 4-30  Import Configuration (xml format) 
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4.4.12 Configure General Setting of the Component 

User can change the general setting of the component such as location and dependency. If user wants to 
change it, click the [Configure general settings...] link on the [Software Component Selection] page displayed 
in the [New Component] dialog (Figure 4-10), and display the [Preferences] dialog. 

 

  

Figure 4-31  Configure General Setting of Component 

 

Notes:  

1. User can limit the number of folders created in the trash folder for backup purposes by setting the 
[Number of trash item (1-20)] option in the figure below. Once exceeding the limit, a folder with the newer 
timestamp will replace the oldest folder. 

 

 

Figure 4-32  Trash number setting 

 

2. The code generation behavior has two options: [Update configuration files] and [Re-generate all 
component files]. [Update configuration files] is the default selection. If "Update configuration files" is being 
selected and generate code, Smart Configurator will check whether the files are existing inside the user 
project. If the file exists, the file will not be overwritten. However, configuration files (e.g., xxx_config.h) will 
still be refreshed when code is generated. If "Re-generate all component files" being selected and 
generate code, Smart Configurator does not check the existence of the file and the file will always be 
overwritten. 

 

  
Figure 4-33  [Code generation behavior] Change 

3. If user wants to only generate initialization API function, user can change to [Output only initialization API 
function] option in below figure. So that only void R_{ConfigurationName}_Create (void), void 
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R_{ConfigurationName}_Create_UserInit (void) in *.h , *.c files are generated. If user changes back to 
default option setting: [Output all API functions according to the setting], then all API functions will be 
generated again.  

 

 

Figure 4-34  [RISC-V MCU API function output] Change 

 

Please right-click the selected component and select the "Output only initialization API" from the context 
menu. 

 

 

Figure 4-35  Context Menu “Output only initialization API” for Each Configuration 

 

4. To generate code with HEX value, please change to [Value without macro description (raw HEX)] option in 
below figure. If user change back to default option setting: [Value with macro description], then all API with 
macro description will be generated again. 

 

 

Figure 4-36  [API code style] Change 

 

5. If the version of the module and its dependency do not match, a warning message W04020011 is 
displayed. If user checks the revision history of the module and its dependencies and you do not need to 
change the module you are using, you can ignore this warning. To clear this warning, select [Do not check 
for dependent component] in the [Checking dependency] list box in component preferences, then click 
[OK]. 

 

 

Figure 4-37  [Checking dependency] Change  
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 Pin Settings 

The [Pins] page is used for assigning pin functions. User can switch the view by clicking on the [Pin Function] 
and [Pin Number] pages. The [Pin Function] list shows the pin functions for each of the peripheral functions, 
and the [Pin Number] list shows all pins in order of pin number. 

  

Figure 4-38  [Pins] Page ([Pin Function]) 

 

When user selects a board on the [Board] page, the initial pin setting information of the board is displayed in 

[Board Function]. In addition, the [ ] icon displayed in the [Function] selection list indicates the initial pin 
function of the board. 

 

  

Figure 4-39  [Pins] Page ([Pin Number])  

Display switching 
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4.5.1 Changing the Pin Assignment of a Software Component 

The Smart Configurator assigns pins to the software components added to the project. Assignment of the 
pins can be changed on the [Pins] page.  

This page provides two lists: Pin Function and Pin Number. 

Follow the procedure below to change the assignment of pins to a software component in the Pin Function 
list. 

(1) Click on [  (Show by Hardware Resource or Software Components)] to switch to the component view. 

(2) Select the target software component (for e.g., Config_ICU). 

(3) Click the [Enabled] header to sort by pins used. 

(4) In the [Assignment] column or [Pin Number] column on the [Pin Function] list, change the pin 
assignment (for e.g., change from P201 to P302).  

(5) In addition, assignment of a pin can be changed by clicking on the [  (Next group of pins for the 

selected resource)] button. Pin that has peripheral function is displayed each time the button is clicked. 

 

 

Figure 4-40  Pin Settings – Assigning Pins on the [Pin Function] List 

 

The Smart Configurator allows user to enable pin functions on the [Pins] page without linking the current 
software component to another. To distinguish these pins from other pins that are used by another software 
component, there will be a remark "There is no software initializing this pin" on the list.  

 

  

(1) 

(2) 

(3) 

(4) 

(5) 
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4.5.2 Assigning Pins Using the MCU/MPU Package View 

The Smart Configurator visualizes the pin assignment in the MCU/MPU Package view. User can save the 
MCU/MPU Package view as an image file, rotate it, and zoom in to and out from it. 

Follow the procedure below to assign pins in the MCU/MPU Package view. 

(1) Zoom in to the view by clicking the [  (Zoom in)] button or scrolling the view with the mouse wheel. 

(2) Right-click on the target pin.  

(3) Select the signal to be assigned to the pin. 

(4) The color of the pins can be customized through [Preference Setting...]. 

  

Figure 4-41  Assigning Pins Using the MCU/MPU Package View 

  

(2) 
(3) 

(4) 

(1) 
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4.5.3 Show Pin Number from Pin Functions 

User can go to the pin number associated with a pin function.  

Follow the procedure below to jump to pin number from a pin function. 

(1) In the [Pin Function] tab, right click on a Pin Function to open the pop-up menu. 

(2) Select “Jump to Pin Number”. 

(3) The [Pin Number] tab is opened with a Pin Number being selected. This is the pin number of the pin 
function. 

 

 

 

 

Figure 4-42  Jump to Pin Number 
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4.5.4 Exporting pin settings 

The pin settings can be exported for later reference. Follow the procedure below to export the pin settings. 

(1) Click on the [  (Export pin assignments)] button on the [Pins] page. 

(2) Select the output location and specify a name for the file to be exported.  

The exported XML file can be imported to another project having the same device part number. 

 

 

Figure 4-43  Exporting Pin Settings to an XML File 

 

The Smart Configurator can also export the pin settings to a CSV file. Click on the [  (Save the list to .csv 
file)] button on the [Pins] page. 

 

4.5.5 Importing pin settings 

To import pin settings into the current project, click on the [  (Import pin assignments)] button and select 
the XML file that contains the desired pin settings. After the settings specified in this file are imported to the 
project, the settings will be reflected in the [Pin configuration] page. 

 

 

Figure 4-44  Importing Pin Settings from an XML File 

 

Note:  The pin setting is reflected, but it is not reflected in the component setting. 

  

(1) 
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4.5.6 Pin setting using board pin configuration information 

User can set the initial pin configuration according to the Renesas board that you selected to use. User can 
check the board that selected to use in [Board] tabbed page.  

The following describes the procedure for collective setting of pins. 

(1) Select a board setting information except [Custom User Board] in [Board] page. User can refer to 4.1.3 
Importing Board Settings. 

(2) Select [Board Function] in the MCU/MPU Package. (The initial pin configuration of the board can be 
referred.) 

(3) Open the [Pin Configuration] page and click the [Assign default board pins]  button. 

(4) When [Assign default board pins] dialog opens, click [Select all]. 

(5) Click [OK]. 

 

 
Figure 4-45  Setting for Initial Pin Configuration 

 

If user does not set pin settings all at once, specify them individually in procedure (4). 
  

(2) 

(3) 
(4) 

(5) 
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4.5.7 Pin Filter Feature 

By specifying the filter range on the [Pin Function] page and [Pin Number] page on the [Pins] page, user can 
refer to it more easily. 

 

 

Figure 4-46  Filter for [Pin Function] Page 

 

 
Figure 4-47  Filter for [Pin Number] Page 
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4.5.8 Pin Errors/Warnings setting 

User can control how pin problem is displayed on Configuration Problems view by using the Pin 
Errors/Warnings setting. If user wants to control it, on the [New Component] dialog, click the [Configure 
general settings...] link to display the [Preferences] dialog. Then select [Renesas] > [Smart Configurator] > 
[Pin Errors/Warnings] and use the combo boxes to change the errors/warning setting. 

 

  

Figure 4-48  Pin Errors/Warnings settings at Preferences  

 

Example: Change “No Software” setting from “Info” to “Error” 

 

 
 
 

 
Figure 4-49 Change “No Software” Setting from “Info” to “Error” 
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 Interrupt Settings 

The [Interrupt] page displays all interrupts by each of the vector numbers. User can check and set the 
interrupts of the peripheral modules that have been selected on the [Components] page. When an interrupt 
is used in a Code Generator configuration on the [Components] page, the status of the interrupt will be 
changed to "Used".  

To display the used interrupts only, click on the [  (Show used interrupts)] button. 

 

 

Figure 4-50  Show used interrupts 

 

4.6.1 Changing Interrupt Priority Setting 

User can change the interrupt priority level on the [Interrupt] page using the following procedure: 

(1) Find the interrupt which user wants to change priority setting on this page. 

(2) Click the priority cell and select an interrupt priority level from the drop-down list. 

 

 

Figure 4-51  Change the interrupt priority level 

  

(2) 
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4.6.2 Interrupt Filter Feature 

By specifying the filter range on the [Interrupts] page, user can find interrupt more easily. 

 

 

Figure 4-52  Filter for [Interrupts] Page 

 

4.6.3 Changing Interrupt Vector or Group Setting 

User can change the interrupt Vector or Group setting on the [Interrupts] page using the following procedure: 

(1) Find the interrupt which you want to change Vector Number or Group setting on this page. 

If the interrupt has been used, please start from step a. 

If the interrupt hasn’t been used, please start from step b. 

a. Please release interrupt by right-clicking on a Code Generator configuration and then selecting the 

[ ] icon changes the icon to [ ] and disables code generation for the 
Code Generator configuration.  

 

 

Figure 4-53  Release used interrupt 

(1) a. 
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b. Change the filter to [interrupt]. 

c. Input filter text (for e.g., ADC_ENDI). 

(2) Find the Vector Number or Group you want to change. 

Note: You cannot select the item which status is Used. 

(3) Click the [Interrupt] cell and select an Interrupt setting from the drop-down list. 

(4) When you use related components or enable code generation by clicking on the [ ] icon 
and change it to [ ], the interrupts with specified vector or group will be used. 

 

 

Figure 4-54  Change Interrupt Vector Setting Example 

 

4.6.4 Resolving Interrupt error 

Use IRQ5 as example, when IRQ5 is used in interrupt component, but an interrupt error is shown in 
“Configuration Problems” view. It means all interrupt vectors which can been used as IRQ5 have been 
occupied. 

 

 

Figure 4-55 An interrupt is not allocated to any interrupt vector number 

(1) b. (1) c. 

(2) 

(3) 
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To solve this error, please release an occupied vector by other components and select a vector number for 
IRQ5 in [Interrupt] page using the following procedure: 

(1) Change the filter to [interrupt]. 

(2) Input filter text (for e.g., IRQ5). 

(3) Find the Peripheral you want to release. 

 

Figure 4-56 How to find the occupied Interrupt 

(4) Right-clicking on ELC and then selecting the [ ] icon changes the icon to [ ] 
and disables code generation for the Code Generator configuration.  

 

Figure 4-57 Disable the component 

(5) The interrupt of ELC has been released. 

(6) Click the [Interrupt] cell and select PORT_IRQ5 from the drop-down list. 

(7) Generate Code again. 

.  

Figure 4-58 Release an occupied Interrupt 

Note: If want to use ELC interrupt again, please start from step (1).   

(2) (1) 

(3) 

(4) 

(6) 

(5) 

(7) 
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 Managing Conflicts  

When adding a component or configuring a pin or interrupt, problems in terms of resource conflict and 
missing dependency modules might occur. This information will be displayed in the Configuration Problems 
view. User can refer to the displayed information to fix the conflict issues. User can generate code even if 
there are conflicts. 

 

 Resource Conflicts 

When two software components are configured to use the same resource (for e.g., ADC), an error mark ( ) 
will be displayed in the Components tree. 

The Configuration Problems view will display messages on peripheral conflicts to inform user in which 
software configurations peripheral conflicts have been detected. 

   

Figure 5-1  Resource Conflicts 
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 Resolving Pin Conflicts 

If there is a pin conflict, an error mark  will appear on the tree and [Pin Function] list. 

  

 

Figure 5-2  Pin Conflicts 

 

Detailed information regarding conflicts is displayed in the Configuration Problems view. 

  

Figure 5-3  Pin Conflict Messages 

 

To resolve a conflict, right-click on the node with an error mark on the tree and select [Resolve conflict]. 

 

  

Figure 5-4  Resolving Pin Conflicts 

The pin function of the selected nodes will be re-assigned to other pins. 
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 Generating Source Code 

Source files can be generated even if there is a conflict in the Configuration Problems view. 

 

 Outputting Generated Source Code 

Output source files for the configured details by clicking on the [  (Generate Code)] button in the 
Smart Configurator view. 

   

Figure 6-1  Generating a Source File  

 

The Smart Configurator generates source files in <ProjectDir>\src\smc_gen and updates the source files list 
in the Project Explorer. If the Smart Configurator has already generated files, a backup copy of those files is 
also generated (refer to chapter 8 Backing up Generated Source Code). 

Note: If user put a self-created source file in smc_gen folder, it will be erased at time of generating source files. 

 

Figure 6-2  Source Files in the Project Explorer  
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 Change Generated Code Location 

(1) To change the generated code location, click on the [Edit] button under Current Configurations at 
[Overview] page.  

 

 

Figure 6-3 Edit the Generated Code Location 

 
(2) In the Folder Selection dialog, select an empty folder for code generation or create a new folder. 

 

 

Figure 6-4 Folder Selection 
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(3) Click on [  Generate Code] button. The source code will be generated in the new location. User 
can also check for the current generate code location in [Overview] page. 

 

Figure 6-5 New Generate Code Location  
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 Configuration of Generated Files and File Names 

Figure 6-6  Configuration of Generated Files and File Names, shows the folders and files output by the 
Smart Configurator. Function main () is included in {Project name}.c, which is generated when the project is 
created by the e² studio. 

R_xxx indicates the names of Software Integration System Modules, “ConfigName” indicates the name of the 
configuration formed by the component settings, and “Project name” indicates a project name set in the e² 
studio. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6-6  Configuration of Generated Files and File Names  
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Folder File Description  

general 

 

 This folder is always generated. 

It contains header files and source files commonly used by Code 

Generator drivers of the same peripheral function. 

r_cg_xxx.h(Note*1) The files contain macro definitions for setting SFR registers. 

r_smc_entry.h This file is always generated. 

This file includes the header files of Code Generator drivers that 

are added to the project. 

When using functions of Code Generator drivers in source files 

added by user, including this file is necessary. 

r_cg_macrodriver.h This file is always generated. 

This header file contains common macro definitions used in 

drivers. 

r_cg_userdefine.h This file is always generated. 

User can add macro definitions in the dedicated user code areas. 

r_cg_systeminit.c This file is always generated. 

This file contains all component’s Create () function, it is used for 

peripheral modules initialization. 

r_cg_xxx_common_user.c(Note*1) The files contain common interrupt API of used peripherals. 

r_cg_xxx_common.c(Note*1) This file is generated when related peripherals are used. 

r_cg_xxx_common.h(Note*1) This file is generated when related peripherals are used. 

r_cg_interrupt_handlers.h This file includes all interrupt routine declaration. If no 
configuration created, all interrupt routine is default routine; if 
specific configuration is created, corresponding interrupt routine 
declaration of this configuration will replace the default routine 
declaration. 

r_cg_inthandler.c This file includes all default interrupt routine definition.  

r_cg_vect_table.c This file includes an interrupt vector table which includes all 

interrupt routine entry address. if no configuration created, all 

interrupt routine entry address is default; if specific configuration is 

created, corresponding interrupt routine entry address of this 

configuration will replace the default routine entry address.  

r_smc_cgc.c This file is always generated. 

It contains the initialization of clock sources other than the clock 

source selected in the [Clocks] page. 

r_smc_cgc.h This file is always generated. 

This header file contains macro definitions to initialize clocks other 

than the selected clock source. 

r_smc_cgc_user.c This file contains functions to be added to R_CGC_Create. 

User can add codes and functions in the dedicated user code 

areas. 

r_smc_interrupt.c This file is always generated.  

It contains interrupt initialization (depending on hardware 

specification). 

r_smc_interrupt.h This file is always generated. 

It contains the priority level of all interrupts that are configured in 

the [Interrupts] tabbed page. User can use these macro definitions 

in application codes. 

r_bsp  This folder is always generated. 

It consists of multiple subfolders (board, doc, mcu) with: 

- Initialization codes to start up the MCU before entering main () 

(e.g. setup stack, initialize memory) 

- Definitions of all SFR registers in iodefine.h (mcu folder) 

- Application note of r_bsp (doc folder) 

It also contains platform.h that will include r_bsp.h of the device 

used in the project. 
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Folder File Description  

r_config  It contains configuration header files for the MCU package, 

clocks, interrupts, and RISC-V MCU Software Integration 

System drivers. 

r_bsp_config.h 

 

This file is always generated. 

It contains configurations of r_bsp for clock initialization and 

other MCU related settings. Some MCU related settings are 

generated by Smart Configurator (e.g. package type) and 

other settings (e.g. stack size) are configured by user 

manually. 

r_bsp_interrupt_config.h This file is always generated. 

It contains mapping of the software configurable interrupts 

(depending on hardware specification). 

r_pincfg Pin.h This file is always generated. 

It is generated for supporting pin symbol and included in 

smc_entry.h. 

Pin.c This file is always generated. 

It is a reference of pin function initialization for all peripherals 

configured in the [Pins] tabbed page (except I/O Ports). 

{ConfigName}  This folder is generated for the Code Generator drivers that 

are added to the project. 

API functions in this folder are named after the ConfigName 

(configuration name). 

{ConfigName}.c This file contains functions to initialize driver 

(R_ConfigName_Create) and perform operations that are 

driver-specific, e.g. start (R_ConfigName_Start) and stop 

(R_ConfigName_Stop).  

{ConfigName}_user.c This file contains interrupt service routines and functions for 

user to add code after the driver initialization 

(R_ConfigName_Create). 

User can add codes and functions in the dedicated user code 

areas. 

{ConfigName}.h This is header file for {ConfigName}.c and 

{ConfigName}_user.c. 

Notes:  1. xxx is the name of a peripheral function. 
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 Initializing Clocks  

Configurations of the clock source selected in the [Clocks] page are generated to the macros in the 
r_bsp_config.h file located in \src\smc_gen\r_config folder. Clock initialization codes will be handled by r_bsp 
before entering main (). 

The r_bsp_config.h file also contains other MCU related settings (for e.g., package, stack size). 

 

 

 

Figure 6-7  Clocks Configuration and Generated Code in r_bsp_config.h 

 

Folder File Macros/Functions Description 

r_config r_bsp_config.h Macros related to 

clocks 

These settings are generated by Smart Configurator 

based on user’s selection in the [Clocks] page for the 

clock source. r_bsp will handle the clock initialization 

before entering main (). 

  Macros related to MCU 

settings 

Some MCU related settings are generated by Smart 

Configurator (e.g. package type) macros. For the detail 

macro information, user can refer to the application note 

in r_bsp folder: \src\smc_gen\r_bsp\doc 

Note:  r_bsp_config.h will be backed up to trash folder before each code generation (refer to chapter 8 Backing up 
Generated Source Code).  
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 Initializing Pins  

Configurations in the [Pins] page are generated in some source files depending on driver’s requirements and 
hardware specifications.  

(1) Pin initialization for drivers with {ConfigName} 

Pin functions are initialized in R_ConfigName_Create of the file \src\smc_gen\{ConfigName}\{ConfigName}.c. 

Pin initialization codes will be handled before entering main (). 

 

 

Figure 6-8  Config_TAU0_1 in Software Components View 

 

Folder File Function Component type Description 

{ConfigName} {ConfigName}.c R_ConfigName_

Create 

Code Generator This API function initializes the pins 

used by this driver.  

r_cg_systeminit will call this function 

before entering main () function. 

 

(2) Reference to pin initialization codes 

Refer to Pin.c in ¥src¥smc_gen¥r_pincfg folder for all peripheral pin functions used in the project (except 
I/O ports). 

 

Folder File Function Driver Description 

r_pincfg Pin.c R_Pins_Create - This file contains the initialization 

codes of all pin functions 

configured in the [Pins] page 

except I/O ports. 

 

 Initializing Interrupts 

Configurations in the [Interrupts] page are generated in some source files. 
Interrupt functions are initialized in R_ConfigName_Create of the file 
\src\smc_gen\{ConfigName}\{ConfigName}.c.  
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Figure 6-9  Interrupts Configuration in Interrupts View 

Item Folder File Component type Description 

Priority  {ConfigName} {ConfigNa

me}.c 

Code Generator It is initialized in R_ConfigName_Create of this 

file. R_systeminit in r_cg_systeminit.c will call 

this function before entering main () function. 

 

 Creating User Programs 

The Smart Configurator can add user code to the output source files. This chapter describes how to add user 
code to the source files generated by the Smart Configurator. 

 

 Adding User Code 

When [Code Generator] or [Graphical Configurator] is selected as the component type, if files which have the 
same name already exist, new code will be merged only with the existing code that is between the comments 
below. 

 

 

 

In the case of [Code Generator], three files are generated for each of the specified peripheral functions. The 
file names are “Config_xxx.h”, “Config_xxx.c”, and “Config_xxx_user.c” as the default, with “xxx” 
representing the name of the peripheral module. For example, “xxx” will be “ADC” for the A/D Converter 
(resource ADC). The comments to indicate where to add user code are at the start and end of *.c files, and 
at the end of *.h file. Comments to indicate where to add user code are also added to the interrupt function 
for the peripheral module corresponding to Config.xxx_user.c. The following example is for ADC 
(Config_ADC_user.c).  

/* Start user code for xxx. Do not edit comment generated here */ 
 
/* End user code. Do not edit comment generated here */ 
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/**********************************************************************************************
************************* 
Pragma directive 
***********************************************************************************************
************************/ 
/* Start user code for pragma. Do not edit comment generated here */ 
/* End user code. Do not edit comment generated here */ 
 
/**********************************************************************************************
************************* 
Includes 
***********************************************************************************************
************************/ 
#include "r_cg_macrodriver.h" 
#include "Config_ADC.h" 
/* Start user code for include. Do not edit comment generated here */ 
/* End user code. Do not edit comment generated here */ 
#include "r_cg_userdefine.h" 
 
/**********************************************************************************************
************************* 
Global variables and functions 
***********************************************************************************************
************************/ 
/* Start user code for global. Do not edit comment generated here */ 
/* End user code. Do not edit comment generated here */ 
 
/**********************************************************************************************
************************* 
* Function Name: R_Config_ADC_Create_UserInit 
* Description  : This function adds user code after initializing the AD converter. 
* Arguments    : None 
* Return Value : None 
***********************************************************************************************
************************/ 
void R_Config_ADC_Create_UserInit(void) 
{ 
    /* Start user code for user init. Do not edit comment generated here */ 
    /* End user code. Do not edit comment generated here */ 
} 
 
/**********************************************************************************************
************************* 
* Function Name: r_Config_ADC_interrupt 
* Description  : This function is ADC_ENDI interrupt service routine. 
* Arguments    : None 
* Return Value : None 
***********************************************************************************************
************************/ 
void r_Config_ADC_interrupt(void) 
{ 
    /* Start user code for r_Config_ADC_interrupt. Do not edit comment generated here */ 
    /* End user code. Do not edit comment generated here */ 
    R_ICU->IELSR15 &= 0xFFFEFFFFU;    /* clear ADC_ENDI interrupt flag */ 
} 
 
/* Start user code for adding. Do not edit comment generated here */ 
/* End user code. Do not edit comment generated here */ 
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/**********************************************************************************************
************************* 

* Function Name: r_Config_ADC_interrupt 

* Description  : This function is ADC_ENDI interrupt service routine. 

* Arguments    : None 

* Return Value : None 

***********************************************************************************************
************************/ 

void r_Config_ADC_interrupt(void) 

{ 

    /* Start user code for r_Config_ADC_interrupt. Do not edit comment generated here */ 

    /* End user code. Do not edit comment generated here */ 

    R_ICU->IELSR15 &= 0xFFFEFFFFU;    /* clear ADC_ENDI interrupt flag */ 

} 

 

/* Start user code for adding. Do not edit comment generated here */ 

/* End user code. Do not edit comment generated here */ 
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 Using Generated Code in User Application 

To use the generated code of Code Generator, in the main function, call the functions generated and add 
application codes. 

Diver initialization functions (R_ConfigName_Create) including initialization of pins have been called in 
R_Systeminit function of r_cg_systeminit.c by default. User just needs to add application codes to perform 
operations that are driver-specific, for e.g., start (R_ConfigName_Start) and stop (R_ConfigName_Stop). 
 

 
Figure 7-1 Call Code Generator Functions 

 

 Backing up Generated Source Code 

The Smart Configurator has a function for backing up the source code at: 

<ProjectDir>\trash\<Date-and-Time>  

The Smart Configurator generates a backup folder for the previously generated source code when new code 

is generated by clicking on the [  (Generate Code)] button. <Date-and-Time> indicates the date and 
time when the backup folder is created after code generation.  
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 Generating Reports 

The Smart Configurator generates a report on the configurations that the user works on. Follow the 
procedure below to generate a report. 

 

 Report on All Configurations (PDF or Text File) 

A report is output in response to clicking on the [   (Generate Report)] button in the Smart 
Configurator view. Two selections of output files are available (PDF, Text). 

 

 

Figure 9-1  Output of a Report on the Configuration (as a PDF/Text File) 

 

 

Figure 9-2  Dialog Box for Output of a Report (Example is selecting “Output as PDF”) 
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 Configuration of Pin Function List and Pin Number List (in csv Format) 

A list of the configuration of pin functions and pin numbers (whichever is selected at the time) is output in 

response to clicking on the [  (Save the list to .csv file)] button on the [Pins] page of the Smart 

Configurator view. 

 

 

Figure 9-3  Output of a List of Pin Functions or Numbers (in csv Format) 

 

 Image of MCU/MPU Package (in png Format) 

An image of the MCU/MPU package is output in response to clicking on the [  (Save Package View to 

external image file)] button of the [MCU/MPU Package] view. 

 

 

Figure 9-4  Outputting a Figure of MCU/MPU Package (in png Format) 
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 Developer Assistance 

Developer assistance function will provide a virtual root node named "Developer Assistance" in project tree 
when Smart Configurator selected in Project Generator.  

Through "Developer Assistance" tree, user can navigate API information in new Smart Configurator 
[Developer Assist Browser] view for the added Code Generator components and user can drag and drop the 
API template node to C/C++ editor during coding. 

 

Figure 10-1  API info Navigate and Call API Drag&Drop 

 
User can select text in [Developer Assist Browser] view and through "Copy" context menu to paste the Code 
Generator component usage example code snippet to C/C++ editor. 
 

 

Figure 10-2  Usage Example Copy&Paste  
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 User Code Protection Feature for Smart Configurator Code Generation 
Component 

This feature empowers users to insert codes to any location in the generated codes by utilizing the specific 
tags, as shown in Figure 11-1. After the next code generation, the inserted user codes will be protected and 
automatically merged into the generated files. 
 
The user code protection feature will be supported on the files that are generated by the “Code Generation” 
component and “Clock” tool. 
 

 Specific Tags for the User Code Protection Feature 

When using the user code protection feature, please insert /* Start user code */ and /* End user code */ as 
shown in Figure 11-1 and add the user codes between these tags. If the specific tags do not match exactly, 
the inserted user code will not be protected after the code generation. 

 

    /* Start user code */ 

    User code can be added between the specific tags 

    /* End user code */ 

Figure 11-1  Specific Tags for User Code Protection Feature 

 

 Examples of Using User Code Protection Feature to Add New User Code 

 

                 

Figure 11-2 shows an example of adding new user code into the Create API of A/D Converter module by 
using the specific tags shown in Figure 11-1. After updating the configuration in the A/D Converter GUI and 
re-generating the codes, the inserted user codes will be automatically merged into the newly generated file. 
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Figure 11-2  User Code Protection with Auto Merge 

  

Inserted the user code 
with the specific tags 

User codes will automatically be 
merged into the new generated file 
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 What to Do When Merge Conflict Occurs 

11.3.1 What is Merge Conflict 

When the lines of generated codes before and after the inserted user codes are updated due to changes in 
GUI configuration or the version update of Smart Configurator, merge conflict codes will be generated out. 

If the merge conflict occurs, conflict message will be displayed in the Smart Configurator console, as shown 
in Figure 11-3  The Merge Conflict Message Outputted in the Smart Configurator Console. 
 

 
Figure 11-3  The Merge Conflict Message Outputted in the Smart Configurator Console 

 

User can click the conflicted file in the console message to open the File Compare view and then can resolve 
the conflict as next chapter 11.3.2 Steps for Resolving the Merge Conflict described. 
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11.3.2 Steps for Resolving the Merge Conflict 

User can follow the steps below to solve the merge conflicts. 
(1) Click on the conflicting file in the console to open the “File Compare” view (Figure 11-4  Code before 

Resolving Conflict). 
(2) Click on “Copy Current Change from Left to Right” (Figure 11-4  Code before Resolving Conflict). 
 

 
Figure 11-4  Code before Resolving Conflict 

 

(3) Move user codes to the place you want to use (Figure 11-5  Code after Applying “Copy Current Change 
from Left to Right” 

 

(1) 

(2) 

(1) 



RISC-V MCU Smart Configurator User's Guide: e² studio 

R20AN0730EC0101  Rev.1.01  Page 71 of 73 

Apr.22.24  

  

Figure 11-5  Code after Applying “Copy Current Change from Left to Right” 

(4) Save the modified code (Figure 11-6  Code after Moving and Saving). 
 

 

Figure 11-6  Code after Moving and Saving 

 

User can also resolve the conflict by editing the code in the right panel directly. 

Note: After conflict resolved, if click the confliction message, it still can open [File Compare] view.  
  

(3). Move user code 
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 Help 

Refer to the help system from the e2 studio menu for detailed information on the Smart Configurator. If 
selected from Help menu, it will prompt out the Help dialog window, it shows all Help topics content. 

 

 

Figure 12-1  Help Menu 

 

The help system can also be activated from the [Overview] page by clicking  button. If selected from 
this page, it will open a Help panel in the current GUI view, it is specially pointing to Smart Configurator 
portion in Help content.  

 

 

Figure 12-2  Smart Configurator Quick Start inform  

 

In both ways to check Help information, the whole Help contents is the same. 
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 Documents for Reference  

User’s Manual: Hardware 

Obtain the latest version of the manual from the Renesas Electronics website. 

 

Technical Update/Technical News 

Obtain the latest information from the Renesas Electronics website. 

 

User’s Manual: Development Environment 

e2 studio Integrated Development Environment User’s Manual: Getting Started Guide (R20UT4374) 

Smart Configurator User’s Manual: RISC-V MCU API Reference (R20UT5385) 

(Obtain the latest version from the Renesas Electronics website.) 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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